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The associations of elements upon a heterogeneous surface may control nutrients or
pollutants sorption and release, having agricultural and environmental implications. This
chemical behavior can be elucidated by spatial spectroscopy, followed by image analysis.
The purpose of this paper is to present a working procedure for image analysis using the
free program Imaged that can be applied for dot maps of three or more elements produced
by solid-state spectroscopy. Detailed step-by-step instructions lead to visual and
quantitative information regarding elements associations. The working procedure was
demonstrated for P, Al and Ca dot maps produced by scanning electron microscopy
energy dispersive spectroscopy (SEM-EDS) for surfaces of Al-based water treatment
residuals (AlI-WTRs), a by-product of drinking water pretreatment with alum coagulant. Al-
WTR was reused to adsorb the macro-nutrient P from polluted soil leach and dairy
wastewater (WW). Surficial P onto A-WTR, SL-AI/O-WTR, and WW-AI/O-WTR (0.56,
0.93, and 2.15%, respectively) displayed sorption dynamics, mostly with Al and Ca.
Quantification of the spatial proportions of individual elements and their associations
indicated P-Al pool > P-Ca pool (45-24% and 17-7%, respectively). Upon introducing
P-rich dairy wastewater, the behavior of P sorption by Al and Ca changed and became
more clustered. A ternary phase of P-Al-Ca covered 38% of the area with signal, compared
to 4.3 and 4.6% of the area in AI-WTR and SL-AI-WTR, where it was limited to particles
edges only. Thus, the presented protocol may promote employing image analysis for
geochemical applications, elucidating chemical behavior and affinities. Advantages and
pitfalls are discussed.

Keywords: image analysis, element dot maps, scanning electron microscopy-energy dispersive spectroscopy,
phosphorus sorption, water treatment residuals

Abbreviations: Al-WTR, aluminum-based water treatment residuals; SL-Al/O-WTR, soil leach-reacted aluminum/organic
water treatment residuals; WW-AI/O-WTR, wastewater-reacted aluminum/organic water treatment residuals; XRF, x-ray
fluorescence; SEM-EDS, scanning Electron Microscopy-Energy Dispersive Spectroscopy; SL, soil leach; WW, wastewater.
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INTRODUCTION

Phosphorus (P) might be an environmental threat for pollution
and eutrophication in aquatic settings when impacted by P-rich
waste streams (Sims and Sharply, 2005). Yet, those streams can be
used as P sources, as P is an essential nutrient for plant growth.
Thus, P recycling is of worldwide interest (see review by
(Wendling et al., 2013)). Aluminum water treatment residuals
(Al-WTR) are known for their great P-sorption capacity (Dayton
and Basta, 2005), and a previous study already presented over
90% recovery of P by Al-WTR from waste streams with high
potential for subsequent release (Zohar et al., 2017). Identifying
major P-binding pools in heterogeneous materials, such as WTRs
(Zohar et al., 2020; Zohar et al., 2018) may facilitate its effective
recovery. For example, P sequential extraction of AI-WTR and
Fe-WTR indicated that major pools to extract P from, were Al
and Ca in AI-WTR and Fe and Ca in Fe-WTR and that following
mixture with dairy wastewater (WW) the labile P pool grew.
However, P surface reactions were emphasized since it was found
that P sorption onto WTRs occurs in two steps; the first is rapid
sorption onto the surface of WTR, and the second is a slow P
diffusion into inner sorption sites (Makris et al., 2004; Massey
etal,, 2018; Zohar et al., 2018). Thus, it is important to thoroughly
examine P dynamics with major pools on top of the materials, as
these dynamics have an essential role in P immediate
sequestration and partitioning out of the solution.
Spectroscopic solid-state examination of the physio-chemical
features and composition of materials surfaces and cross-sections
in various scientific fields has increased in recent decades because
this approach is less destructive than chemical extraction or more
efficient than laborious investigations. In some cases, image
analysis, e.g, using Image] software, accompanies
spectroscopic ~ analysis,  contributing to  improving
understanding of micro and macro processes affecting the
materials or the study areas. Many biological and biomedical
studies used Image] software for image analysis e.g. (Stauffer
et al., 2018; Suarez-arnedo et al., 2020; Valente et al., 2017). Geo-
physical applications included sedimentary studies (Palma et al.,
2019; Fugere et al., 2020) and minerals and salts identification. In
the latter case, spectroscopic 2-D dot maps provided spatial
information on the distribution and associations of the
chemical components, with implications for geology,
geomorphology, archeology, hydrology, and construction e.g.
(Cardell et al., 2002; El-Gohary, 2016; Kahn et al, 2002;
Viazquez et al, 2013). In those cases, the association of two
elements provided an indication for the presence of specific
salts and minerals, based on their principle ionic chemical
composition. However, this approach does not apply when
analyzing more complex geochemical situations, like, when the
elements of interest are involved in various sorption mechanisms
instead of comprising distinct mineral lattices. For example,
surface complexes of physical or chemo-adsorption nature and
surface complexes initiating precipitation (Avnimelech, 1980;
Khare et al.,, 2005; Ler and Stanforth, 2003), with different
pools on heterogeneous surfaces, differently impact the
solubility of the sorbed elements and their recovery. Thus,
elemental partitioning among significant binding pools may
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become more relevant than the presence of salts and minerals.
This is the case with P, which sequestration includes both
adsorption sites onto surfaces and discrete precipitates in poor
and in rich P samples (So et al., 2011; Zohar et al., 2018).

This paper presents a detailed image analysis procedure of
images obtained by scanning electron microscope energy
dispersive spectroscopy (SEM-EDS) of Al-WTR materials. This
working procedure enables quantification or semi-quantification
of elemental associations with two other elements, allowing for
affinity determination and deciphering special chemical features
and their spatial distribution. In this way, the proposed image
analysis is innovative and enables elucidation of more complex
chemical interactions than mere association of two elements,
which implies the presence of a compound. As a case study, the
procedure is demonstrated for P, Al, and Ca in an AI-WTR
sample to elucidate P associations with Al and Ca surfaces. The
combined analyzed image is compared to the original SEM-EDS
dot maps overlay image, emphasizing how they complement each
other, adding new insights. The image analysis procedure was
applied to two other Al-based WTRs under different treatments
and comparison of the final analyzed images enabled a better
understanding of P retention trends and processes under various
conditions. Advantages and pitfalls of the working scheme are
discussed. This working procedure applies to various solid-state
examination techniques that yield elemental dot maps when
desiring insights regarding the association of several elements.
Although the demonstration below consists of 3-element dot
maps, it is possible to apply this image analysis working
procedure to a larger number of elements.

MATERIALS AND METHODS

Sample Preparation
Al-WTR formation and organic composites’ production, Al/
O-WTRs, are described in detail in (Zohar et al, 2017). In
brief, AI-WTR, the residue of surface water clarification
treatment (Eshkol reservoir, Israel; 0.002-0.04 mg P L!
(IOLR, 2016)) using alum coagulant (Al,(SO4);-4H,0) was
air-dried and crushed to < 2 mm grain size. Being the residue
of surface water clarification, it contains Al hydroxides (forming
following alum application to water), deposited suspended solids
(e.g., clay colloids and calcium carbonate), organic particulates,
etc. Subsequently, the dried residual sludge was reused to recover
P from two organic waste streams: contaminated soil leach (SL)
and dairy WW. Both SL and WW streams were pre-clarified from
organic solids by centrifugation before mixture with AI-WTR.
The soluble inorganic P was measured in the clear liquor (11.5
and 43 mg P L™, respectively). Al-WTR recovered phosphorus by
shaking a mixture containing a ratio of 9 g to 1 L waste liquid (SL
or WW) for three days to ensure solid-solution equilibrium; the
enriched solid products of this process, namely SL-Al/O-WTR
and WW-Al/O-WTR, were each separated from the solution by
centrifugation; P recovery level was about 95% (Zohar et al,
2017).

The original AI-WTR and the two products, SL-A/O-WTR
and WW-AI/O-WTR, were examined by SEM equipped with
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Image analysis of the 1st element dot-map

Open image in Imagel

*Drag and drop an image to the Image) menu or
copy it in its location, stand on Imagel menu and
paste. Alternatively, use Import command.

Set resolution

*Choose a straight line selection tool from the
menu, carefully stretch it along the scale bar in
your image.

*Analyze>Set scale: fill in “known distance” and
units (#1) U

Cropping the ROI

*Choose a rectangle tool from the Image) menu,
carefully stretch it along the region of interest
(ROI) to be analyzed (#2).

* Analyze>Tools>ROl manager>Add. The
dimensions of the ROI will appear in the window in
a yellow rectangle (#3).

*Image>crop.

Repetition of the

Designation of numerical
value to each element

procedure for 2 other  [m=p d bl == Image combination
elements ancpossiv’e
associations

Set scale, same as the
scale set for the previous
image.

U

In the cropping stage,
use same ROI

¢In the ROl manager
window, stand on the
line of the dimensions.

elmage>crop (#6).

Assign 1 for the 15
element, 2 for the 2™
element and 4 for the 3™
element (#8).

4

Process>Math>
subtract: for the 1<t
element fill in 254; for
the 2"¢ element fill in

Add one image to
another: Process>Image
calculation>Add: choose
2 of the images
modified in the previous
stage (#10) from the
drop-down list.

g

Add the third image to
the combined image,

Iy 253 and for the 3 following the same
element fill in 251 (#9). operations (#11).
Image is filtered and
binarized Produce a histogram:
@ *Press Ctrl+H

Evaluation of area

*Press “List” in the
histogram window. Save

elmage>Adjust>Color threshold (#4). (#7)

* Press “Filtered”

Transform to binary image

s|lmage>Type> 8 bit
sImage>Adjust>Threshold: move the two sliders to
255. Press “Apply” (#5).

g covered by each the list as an Excel file
_— : s element: for each (#12).
Filtering data of importance elemental image: Ctrl+M @

FIGURE 1 | Flow-chart diagram of the image analysis working procedure; demonstration of a system with three elements. Numbers refer to listed notes.

Stretching the
component values:
e|lmage>Adjust>Brightn
ess/contrast.

*Press Set: change
maximum displayed
value to 7.

ePress: Apply (#13).

EDS (JEOL JCM-6000 Bench-top, Japan). Analysis performed by
SEM-EDS includes information regarding the very thin layer
(~1 pm deep) at the surface of the examined material, in
agreement with the focus of the study of surface sorption
reactions. Consistently, SEM-EDS analyses were performed on
noncoated particles, directly mounted on double-sided adhesive
copper conducting tape (3M®). Analyses used a 15kV
accelerating voltage at 2000 fold magnification, with back-
scattered electrons collected under low vacuum. In the SEM-
EDS program, distinct characteristic X-rays emitted by each
element, following the bombardment of the specimen with
high energy electrons (for technique overview and analysis, see
(Friel, 2003)), is translated to a 2D spatial image of the sample
(i.e., dot maps), representing the counts of the identified X-ray
energy emissions. For each of the three materials, dot maps of
different elements were produced, including P, Al, and Ca and
their overlay maps were produced.

Image Analysis Working Procedure

The working procedure of image analysis was developed for
Image] software (Image] 1.05i, Wayne Rashband, National
Institute of Health, United States) and was applied to the dot
maps of each of the three elements (namely, P, Al, and Ca) in each
of the materials: AI-WTR, SL-Al/O-WTR, and WW-Al/O-WTR.
The image processing procedure consists of first-level
segmentation by binary transformation of the dot maps of

each of the three elements, followed by a second-level
segmentation by combining the three elements’ binary images
using rational operators. Figure 1 and the technical notes that
follow describe the image analysis working procedure in detail,
including the use of menus and sub-menus of ImageJ software
(see selected menus in Supplementary Figure S1).

A preliminary principal step in the analysis is filtering the
image by the automated Brightness threshold. Brightness
represents the amount of white in each pixel, making this
parameter most appropriate for thresholding SEM-EDS
images, since Brightness is predominantly determined by the
intensity (relative concentration) of the element in a specific
location. Hence, areas in the physical sample with a higher
concentration of the element, will show higher intensity
(“more white”) in the SEM-EDS image and be given a higher
Brightness value. The automated threshold value varies among
images (i.e., different dot maps). The ‘cut-off” value is based on
the IsoData method, also known as iterative intermeans (Ridler
and Calvard, 1978): the procedure divides the image into object
and background by taking an initial threshold and computing the
averages of both the pixels at or below the threshold and pixels
above it. The average (mid-value) of those two values is
computed, and the threshold is incremented accordingly. The
process is repeated until the threshold is greater than the
composite average. The resulting filtered image is binarized for
object and background (255, 0, respectively), in the next step.
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Segmentation is crucial; however, its error is unknown as there
is no reference to compare it with (lassonov et al., 2009). Other
than concentration, Brightness may also be affected by the angle
of incident radiation, the reflectance of the sample and the nature
of the analyzed element. The SEM image is sensitive to
morphology of the particle, ie., its microtopography since
distance influences X-ray photons’ counting and, therefore,
intensity (Bauer et al., 1983). This is a pitfall in unpolished
samples or non-smoothed plain samples. To partly overcome
this, only multiple-count localities in the image were chosen for
investigation. The automated threshold changes from image to
image, reflecting the program’s sensitivity (Vazquez et al., 2013);
however, in cases that include microtopography, the nature of the
results may be defined only semi-quantitatively. This is further
elaborated on in the case study demonstrated below.

The following segmentation level consists of operations
based on elementary arithmetics, including designating a
specific value to each image object and subtracting and
adding functions. The result is one image that sums the
information from 3-elemental images and which obtains
eight different segments. The segments include "empty" areas,
areas occupied by individual elements, and areas with varying
combinations of the three elements. Enabling differentiation of
those segments and their semi-quantification can potentially
contribute to deciphering geochemical and physical features,
like chemical affinity, distribution of chemical entities and
physical porosity.

Notes by numbers in the flow chart (Figure 1).

#1 The calculated resolution will be written in pixels per units,
as you reported. The “Set scale” box can be used to set the same
scale for image processing of the following elements.

#2 Zooming in (Ctrl+T) can improve accuracy. The region of
interest (ROI) should contain all dots that express the object’s
presence, but not any other parts of the image (e.g., the scale
bar, frame, technical details). Thus, the rectangle that defines
the ROI should not include them (Supplementary
Figure S1A).

#3 Keep the ROI manager window open for later use
(Supplementary Figure S1A).

#4 Note that the diagrams should be in the HSB method (Hue,
Saturation, Brightness). Change if needed in the “Color space”.
Note that the Threshold color is “white” and that the
“Thresholding method” is “Default” (Supplementary
Figure S1B). Note the value chosen for minimum in the
“Brightness” diagram. The Hue and Saturation ranges
should be 0 to 255. Following filtration, the object will
appear white, while the below-the-threshold background
will appear dark in color. Pressing Ctrl + H will yield a
histogram window presenting some statistical details and a
histogram with the threshold and background proportion
mark. When placing the pointer at the end of the scale, on
the value “255”, the count of object pixels is displayed, and
likewise, when placing the pointer on the visible peak of the
signals below the threshold.

#5 Binary transformation menus are
Supplementary  Figure  SI1C.

displayed in
After  the  binary

Image Analysis of Phosphorus Sorption

transformation, when moving the pointer over the image,
the value in the results bar (in the main menu) is either 0
(white) or 255 (black). It is recommended to duplicate the
image (Ctrl + shift + D) and save it to your files as this is the
final image of a specific element before all elements’ images
are added.

#6 A yellow rectangle will appear on the activated image upon
selecting the ROI dimensions from the ROI manager window.
Those are the dimensions set in the first image analyzed.

#7 The “Results” window will open, showing the total area of
the element. When repeating this operation for another
element’s image, the new value will appear in the "Results"
window. After completing this for the three elements, it is
advised to save the results as an Excel file. Alternatively, you
can derive this information from the final Excel results file
obtained for the list of values (0-7) described in comment #12,
below. Note that the three elements’ percentage does not sum
to 100% as the ROI contains both overlapping elements and
empty areas.

#8 Assigning a number to each element (in your records) will
enable identifying single elements and their associations in the
combined final image by a specific tone and a numerical value.
Adjusting the assigned values will allow considering more than
three elements. See also comment #9.

#9 A subtraction operation leads to the object in each of the
elemental binary images receiving an assigned value, namely, 1
(1st element, very light-toned image), 2 (2nd element), or 4
(3rd element). Further summation of the three images will
result in a combined image with segmented areas with values
from 0 to 7 (Table 1). For example, in case four elements are of
interest, the 4th element should be designated 8, and further
combinations will include 9 (1st +4th elements), 10 (2nd +4th
elements), 11 (Ist +2nd+4th elements), and so on.

#10 The box “Create new window” should be checked. The
resulting combined image is named “Result of..” and will have
very light gray tones.

#11 The resulting combined image (named “Result of Result of
... 7) will be in light gray tones as the tones range from 0 to 7
out of 255.

#12 The list will include the area covered by any of the
components, with values 0 to 7. Save the list for further
analysis.

#13 Now the image will show the various areas in more visible
darker gray tones. This is because each of the tone values (Xi;
Xi = 0-7) now has a tone value of Xi*(255/7), i.e., Xi*36.4. Save
the final image for further qualitative analysis.

RESULTS AND DISCUSSION

The Al-Based Water Treatment Residual

and the Organic Composites, Al/O-WTRs

The main P pools on the AI-WTR surface, before and after
reaction with SL or with dairy WW, were Al oxides and Ca
minerals (Zohar et al., 2020). Obviously, these pools compete for
P sorption when AI-WTR is mixed with P-rich streams.
Interestingly, this competition was further emphasized when
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TABLE 1 | Possible values for theoretical identity (1-7) in a combined image for three elements and results of the elemental images combination.

Value 0 1 2 4 5 6 7
Theoretical 1% glement 2" element 18t 4 ond 3" element 18t 4 3 ond 4 grd 18t 4 ond 4 g
identity (standalone) (standalone) elements (standalone) elements elements elements
Real identity None P Al P+ Al Ca P + Ca Al + Ca P+ Al + Ca
Appearance White Gray scale from light to dark Black
Proportion 32.6% 6.7% 71% 30.4% 8.1% 11.6% 0.3% 3.1%
Normalized 10.0% 10.6% 45.1% 12.1% 17.3% 0.4% 4.6%
proportion

TABLE 2 | P, Al and Ca oxide proportions on surfaces and in whole samples of AI-WTR, SL-AI/O-WTR and WW-AI/O-WTR. Modified from (Zohar et al., 2017).

SL-AlI/O-WTR

WW-AI/O-WTR

AI-WTR
Surface Whole-sample (XRF) Surface (SEM-EDS)
(SEM-EDS)
p? 0.56% 1.25% 0.93%
Al% 20.2% 10.5% 20.9%
Ca% 10.6% 18.7% 9.4%

AFlements represent the reported oxide form of each (i.e., P;Os, Al:O3, CaO).

Al/O-WTR was allowed to re-equilibrate in KCI solution for
62 days, resulting in Ca enhanced solubility and P-Al enhanced
re-sorption after about 14 days, demonstrating P greater affinity
to Al (Zohar et al, 2017). The mechanisms governing P
sequestration were studied thoroughly previously and were
found to consist of adsorption onto Al hydr(oxides) and
CaCOj surfaces, as well as co-precipitation with Al and Ca
(Massey et al., 2018; Zohar et al., 2020; Zohar et al., 2018). It is
important to emphasize that the Al/O-WTR materials are not
pure, being residues of organic and inorganic environmental
waste materials, hence they display high heterogeneity. Thus, P
sequestration may also involve relatively weak physical
adsorption onto low surface affinity constituents (e.g., silica
surfaces (Zohar et al., 2018)). Additionally, P may sequester to
constituents of strong adsorption, which are of low abundance
in WTR and thus their effect is negligible. For example, content
of iron (hydr)oxides in Al-WTR was 4.4%, decreasing to 4.2%
after mixture with WW (Zohar et al., 2017), iron surficial
coverage in Al-WTR was very low (data not shown) and
consistently, pool of P-sorbed to Fe (hydr)oxides in the final
WW-AI/O-WTR was less than 5% (Zohar et al.,, 2020). It
follows, the current study focuses on P association with the
components that displayed the most important role in P
sorption, namely, Al and Ca surfaces.

The produced Al/O-WTRs were enriched with P, while the
Al and Ca proportions mainly remained unchanged (Table 2).
Since Zohar et al. (2017) stressed the importance of the Al-WTR
active surfaces for various P sorption mechanisms, SEM-EDS
images were acquired for non-polished particles so that P
affinity to Al and Ca surfaces could be studied. However, the
image analysis results, in this case, are semi-quantitative. The
working scheme is demonstrated for the SL-Al/O-WTR surficial
dot maps of P, Al, and Ca. The resulting summed image is
compared to segmented images of Al-WTR and WW-Al/

Whole-sample (XRF) Surface (SEM-EDS) Whole-sample (XRF)

1.84% 2.15% 2.70%
10.2% 20.1% 9.4%
16.7% 11.0% 19.8%

O-WTR to emphasize trends and processes in elements’
distribution and association.

Image Analysis of the SL-AlI/O-WTR
Scanning Electron Microscopy Energy

Dispersive Spectroscopy Images

The original SEM-EDS dot maps of P, Al, and Ca and their
overlay images of a 40 m width particle surface of SL-Al/O-WTR
are presented in Figure 2 The specific color combinations
recognize P’s associations with Al and, Ca: P associations with
Al or Ca are marked in yellow or magenta, respectively, while the
ternary association (P, Al, and Ca) is marked in white.

Upon performing the image analysis protocol, the dot maps
of P, Al, and Ca were each cropped and filtered according to the
automated color threshold for Brightness. Interestingly, the P
threshold (102/255) was lower than those of Al and Ca (121,
122/255, respectively). This trend repeated itself for P, Al, and
Ca dot maps of AI-WTR and WW-Al/O-WTR, possibly because
of differences in elemental intensities or due to technical
artifacts. Areas with microtopography of “deep trenches” in
the physical specimen displayed a low signal in the back-
scattered image, i.e, in P dot map (Figure 2), and were
consistently filtered out of the P, Al, and Ca images (Figures
3, 4) performing a mutual effect. The difference between the P
threshold value and those of Al and Ca thus appeared to account
for the low P concentrations.

Further transformation to the binary format enabled
quantifying the area of each of the elements. Although the P
content of the sample was substantially lower than that of Al or
Ca (0.93%, compared with 20.9 and 9.4%, respectively, Table 2),
it covered the largest area in SL-Al/O-WTR image (52.2%
compared with 40.5 and 23.1%, respectively, Figure 4). As all
pixels with the above threshold values received the exact value of
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C—— 10 pm PK| ——=10 ym

AlK| ——=10 ym Cak

and right, respectively).

FIGURE 2| SL-AlI/O-WTR in the back-scattered image (top left), 3-element overlay image (top right) and individual dot maps of P, Al and Ca (lower left, center

below the color threshold constitute 47.75% of the total signals (right).

FIGURE 3| P in SL-A/O-WTR, after color threshold filtration (brightness threshold 102/255). All signals beyond the color threshold turned white (left). The signals

47.75% of 52.25% of signals,
signals, below the beyond the color
color threshold threshold

Count: 141050 Min: 1
Mean: 146.430 Max: 255
StdDev: 113.735 Mode: 255 (73698)

255 regardless of their different intensities, the spatial results
demonstrate how each element’s distribution pattern, rather than
its concentration, is emphasized by this working procedure.
Elemental distributions suggest a scenario where P
introduction upon mixing with SL to AI-WTR triggered rapid
sorption by all the potential sorbing components and mainly by
the dominant constituents, Al and Ca, finally yielding substantial
cover. The presence of Al in the AI-WTRs was shown to be
governed by amorphous Al (hydr)oxides, probably precipitated
upon AI-WTR formation following the addition of the alum
coagulant to the surface water (Zohar et al, 2020). This can
explain the high cover of Al (hydr)oxides on the surface. Calcium
(associated with C, data not shown) was predominated by calcite,

CaCOj; (Zohar et al,, 2020), and characterized by a particulate
nature.

The objects in the P, Al, and Ca images attained a value of 255
following binarization; thus, to assign each object a different
value, each image was subjected to a different subtraction value. A
value of 254 was subtracted from the P image, resulting in the
object obtaining a value of 1. Similarly, the objects in the Al and
Ca images obtained values of 2 and 4, respectively, after 253 and
251 were subtracted from their respective images. An arithmetic
operation of adding in two stages resulted in a combined image of
the three elements. According to their numerical values, the
chemical information was displayed in segments of 8 tones, as
presented in Table 1 and Figure 4 (bottom row, left image). The
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FIGURE 4 | Top row: P, Al and Ca individual filtered, binary images, and the areas occupied by each element on SL-Al/O-WTR surface. Bottom row: Combination
of three elemental (P, Al and Ca) images of SL-AI/O-WTR. Segmented image, processed by the image analysis working procedure (left) compared to the SEM-EDS

SEM-EDS 3-element overlay map of SL-Al/O-WTR is shown at
100% contrast for comparison (Figure 4, bottom row, right
image), to improve the emphasis of elemental associations and
features. It should be noted that a color image (the SEM-EDS,
right) is superior to the gray-scaled image (analyzed image, left)
for directly depicting the chemical components. This can be
partly compensated by inspecting the segmented image while
activated in Image]J, allowing for dynamic identification of the
various segments (presenting the 0-7 values in the results pane
while hovering over the image with the pointer).

The two images in Figure 4 (bottom row) are comparable, and
much of the chemical information can be obtained from both.
However, the image analysis added semi-quantitative
information, which allowed determining the predominating
pool for P sorption. Quantification was improved by
normalizing P, Al, and Ca to the fraction of the occupied area
(i.e., total area minus the empty area). The association of P with
Al was almost three times greater than its association with Ca
(45.1 and 17.3%, respectively, Table 1), although Al cover was less
than twice that of Ca (40.5 and 23.1%, respectively, Figure 4),
indicating P highest affinity to Al (see further discussion in the
following section). The processed image also strongly emphasized
the ternary phase of P, Al, and Ca (black in Figure 4, bottom row,
left) and the nature of its spatial distribution. Interestingly, the
ternary phase was primarily found at Al and Ca bordering
surfaces in the presence of P. This preliminary information
can contribute to the study of mechanisms and processes
involved in the formation of this mutual phase.

This image analysis working procedure can improve our
understanding of the elements’ distributions and associations;
however, presenting the segmented image can be aided by being
coupled to the SEM-EDS overlay map for rapid chemical
identification. Thus, those two means of image presentation
can be complementary.

Comparison Between Al-Based Water
Treatment Residual, SL-AlI/O-WTR, and
WW-AI/O-WTR Based on Their Image

Analyses

The Al-WTR, SL-Al/O-WTR, and WW-AI/O-WTR were each
produced from three different solutions, with varying
concentrations of P (the Sea of Galilee with 0.002-0.04 mg P
LY, (IOLR, 2016), directly affecting the original AI-WTR, SL
(I11.5mg P L™, and dairy WW solution (43 mg P LY,
respectively). Therefore, the materials differ in their P content.
Comparing the segmented images of Al-WTR, SL-Al/O-WTR,
and WW-Al/O-WTR can elucidate trends in P associations and
distributions (Figure 5 and Table 3). The proportion of the
empty area (i.e., area with a value of 0) increased in the order Al-
WTR < SL-A/O-WTR < WW-Al/O-WTR (27.9, 32.6, and
40.9%, respectively, Table 3A). Normalization of the elemental
proportions is essential when comparing different samples
because of the potential impact of sample morphology and
local microtopography and the presence of other elements;
thus, the proportions of P, Al, and Ca were normalized to the

Frontiers in Environmental Chemistry | www.frontiersin.org

July 2021 | Volume 2 | Article 719300


https://www.frontiersin.org/journals/environmental-chemistry
www.frontiersin.org
https://www.frontiersin.org/journals/environmental-chemistry#articles

Zohar and Haruzi

Image Analysis of Phosphorus Sorption

SL-Al/O-WTR

FIGURE 5 | The segmented images of AI-WTR, SL-AI/O-WTR and WW-AI/O-WTR.

TABLE 3 | Elements and their associations, A. the results of the image analysis, B. the results normalized to the total occupied area.

A. Proportions of elements and associations over the entire area

B. Normalized proportions of elements and associations according to the
occupied area

AI-WTR SL-Al/O-WTR WW-AI/O-WTR

None 27.9 32.6 40.9
P 16.7 6.7 4.8
Al 10.2 71 4.8
P+ Al 21.5 30.4 14.3
Ca 7.9 8.1 6.1
P+ Ca 1.6 1.6 4.3
Al + Ca 1.0 0.3 2.2
P+ Al + Ca 3.1 3.1 22.6

100.0 100.0 100.0

Total coverage of all area

P 53 52 46
Al 36 41 44
Ca 24 23 35

occupied area in each of the three AI-WTRs (Table 3B). Table 3A
presents the original data for comparison, yet the discussion
below refers to the normalized data.

In terms of P associations, the Al pool appears to be more
significant than the Ca pool, in all three AI-WTRs (45-24% and
17-7%, respectively, Table 3B), consistent with previous studies of
Al-WTRs (Ippolito et al., 2003; Makris et al., 2004). Nevertheless, in
contrast to previous studies, Ca was an essential pool for P,
potentially affecting P sorption and recovery. Calcium in the
Israeli AI-WTRs is attributed to the treated water: hard surface
water of the Sea of Galilee (IOLR, 2016).

The proportion of standalone elements followed a decreasing
trend with increasing P content of the materials, suggesting that
excess P concentrations promoted clustering of P, Al and Ca on
the surface. Moreover, the segmented images of the three Al-WTRs
reveal interesting information regarding the presence of the ternary
phase of P, Al, and Ca. This phase may be stable where P, Al, and
Ca are abundant (Allen and Hajek, 1989). The proportion of the
P-Al-Ca phase was very similar for Al-WTR and SL-AI/O-WTR
but increased substantially in the WW-Al/O-WTR sample (4.3,
4.6, and 38.3%, respectively, Table 3B). Since P content was the

Al-WTR SL-al/l0O-WTR WW-AI/O-WTR
%

Area w/signal 72 67 59
P 23.2 10.0 8.2
Al 14.2 10.6 8.0
P+ Al 29.8 45.1 24.2
Ca 11.0 121 10.3
P+ Ca 16.1 17.3 7.2
Al + Ca 1.4 0.4 3.7
P+ A+ Ca 4.3 4.6 38.3

100.0 100.0 100.0

Total coverage of occupied area

P 73 77 78
Al 50 61 74
Ca 33 34 60

main variable factor in the chemical compositions of SL-Al/
O-WTR and WW-Al/O-WTR following introducing Al-WTR
with SL and WW, respectively, the formation of the ternary
phase may have required exceptionally high P concentrations.
Furthermore, Table 2 indicates that P content on the surface
of SL-Al/O-WTR was 0.93%, increasing from 0.56% following the
introduction of SL to AI-WTR, while introducing the P-rich dairy
WW to AI-WTR increased P surficial content to 2.70%. In fact,
the increase in surficial P content with higher concentrations of
introduced P exceeded the growth rate for the XRF-whole-sample
P content. Zohar et al. (2017) suggested that exceeding
concentrations of P promoted its preferential accumulation on
top of the WW-Al/O-WTR particles rather than in inner pores.
The current image analysis also suggests that this accumulation is
mainly in the form of the P-Al-Ca phase. Additionally, in both Al-
WTR and SL-Al/O-WTR, the P-Al-Ca phase appears at Ca
surfaces’ edges (probably small CaCO; particles) when
bordering Al and P surfaces. In contrast, in WW-Al/O-WTR,
the ternary phase commonly appears in rather large collections,
not limited to particle edges (Figure 5). Complexes with organic
moieties in the WW (Zohar et al., 2017) probably contributed to
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enhanced solubility of Ca and Al; subsequently, the metals re-
precipitated (similar to (Ler and Stanforth, 2003)) with the
excessive concentrations of introduced P in WW, on top
WW-Al/O-WTR surfaces.

CONCLUSION

The presented working procedure for image analysis of three-
element dot maps consists of signal filtering, binary image
transformation, segmentation to distinguished phases, and
associations’ quantification/semi-quantification. Indeed, the
primary outcome is quantifying the spatial cover of
individual elements and their associations, overcoming an
otherwise vague visual impression. Nevertheless, the final
segmented image may elucidate and emphasize chemical and
physical features, like elemental spatial distribution and
porosity. Rapid identification of elements can benefit from
comparing the segmented gray-scale image to SEM-EDS
color overlay map. In case surface chemical behavior is of
interest, the use of unpolished specimens is mandatory, as
surface reactions are the initial sequestration step. The
proposed image analysis procedure becomes helpful as it
overcomes potential biases by microtopography (porosity) by
using automated Brightness Thresholding. Yet, while elemental
distribution (and thus, chemical affinity) is emphasized, the
processed image does not reflect elemental concentration. The
working procedure was demonstrated for dot maps produced by
SEM-EDS, yet it can be applied to dot maps produced by any
solid-state spectroscopic technique. Moreover, the working
procedure was set up to allow modifications to analyze dot
maps of more than three elements.

Application of the image analysis working procedure to the
dot maps of AI-WTR, SL-Al/O-WTR, and WW-Al/O-WTR
yielded semi-quantitative data indicating that P had a higher
affinity to Al than to Ca in the three materials. In SL-Al/O-WTR,
P spatial distribution was more extensive than Al and Ca,
although P content was much lower, suggesting scattered
sorption on both weak and strong binding sites upon SL
mixture with AI-WTR. On the other hand, with increasing P
content in the WW solution, the elements were more clustered in
WW-Al/O-WTR. P-Al-Ca’s ternary association was recognized
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